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WPC file viewer

Simply go to File > Open... and the WPC window will open. 
Within the WPC window, simply make sure the Enable 
Preview box is checked and then when you browse your 
computer and select a wpc file, it will automatically be 
shown in the lower part of the window.  You will see the file 
just as it would appear when opened in WinPCSIGN. 

You can now simply browse through your many, many wpc 
files to find just the right one, without opening each file 1 at 
a time to see what it looks like. And, it gets better! 

 

  

While you are browsing your 
wpc files, you can also 
easily and quickly delete or 
rename any of them. 
 Simply select the file, wait 
a moment and click again 
1 time directly on the file 
name.  The appearance of 
the file name will change 
from selected to highlight 
and you can then type the 
new name. Just be careful 
to not delete or change the 
wpc extension.  You can 
also right click the file name 
and select rename. 
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Erase small details of Vectorization and Simplify path

This function allows you to erase the small undesired details 
after the vectorization 

Select Vectorization function from Bitmap menu and 
click Automatic to open the vectorization screen. 

 

  

From Vectorization screen 
select the desired 
Vectorization 
function: Bezier, 
Enhanced Curve or Corner 
to convert your image. 
When the Vectorization it’s 
done, Scroll the Bar to 
the right to start erasing 
the small details of your 
vectorization. If you scroll 
the bar to the left, you will 
recuperate it. 
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Brush Transparency 

It works much like the transparency features in programs like 
Photo Shop and  Elements, in that it controls the 
Transparency/Opacity of a selected items fill color. Note that 
this feature is only applicable to closed vector shapes that are 
color filled. It will not work on open paths or raster images:   

  
 

Select Brush transparency from Color palette. WinPCSIGN 
will open the brush transparency slider. Select your drawing 
then move the slider from 0% to 100%, WinPCSIGN will 
apply the transparency to your design. 
See the example below:  
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Brush Transparency example: 
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Automatic backup 

Create a backup of your selection. 

This function allows you to create automatic copy of your 
current job. The job will be saving in Backup folder. 

   

Select Setup from Setting 
Menu, then 
open Save, dialog bar 
and select Enable in Auto 
Save Backup in.. and also 
enter the time that you 
want the software save 
your document and press 
Ok to save. 

If you want Recuperate 
your backup files, 
select Recovery from 
File menu 
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Bottom Zoom selection bar

The new bottom Selection Bar allows you to quickly select: 

 

Create a Zoom Windows 
Apply Zoom preview 
Apply Zoom selected 
Apply Zoom all 
Apply Zoom page 
Apply Zoom small 
Show your drawing in Wire frame on/off 
Apply Construction point 
Apply Color Scheme 
Open Rhinestone screen 
Open T-shirt screen 
Cut personalize Region text from image 

Zoom In/Out
 

Easy selection with a key. This function allows you to 
enlarge or reduce your view. 

Zoom in: 
Select Zoom Icon and press Shift key and hold it while you 
click to zoom in your selection. 

 Zoom out:  
Select Zoom Icon and press Ctrl key and hold it while you 
click to zoom out your selection. 
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Group/Ungroup 

This function allows you to group or Ungroup your 
selection using your mouse. 

Short Cut: Ctrl + G / Ctrl + U 

As soon as you will encircle a selection . the software will 
automatic show a little node icon. 

  
 
Swirl creation

This function allows you to draw arcs and to create perfectly 
and smooth nice curves. 

 

 

  

Click on,   if you 
want Group and click 
again if you want 
Ungroup 

 

Select Arc from path icon 
from Tool bar, draw your first 
arc, then press Shift key and 
hold it 
while you drawing your 
second arc. Continue to draw 
arcs to get the desired shape. 

 

Procedure: 

Select Arc from path icon from 
Tool bar, draw your first arc, then 
press Shift key and hold it 
while you drawing your second 
arc. Continue to draw arcs to get 
the desired shape. 

 



WinPCSIGN Pro 2014                                             New features 

9 
 

Creation Lattice
 

Create a beautiful lattice design out of any shape using the 
Lattice 

 

 

 

 

Example: 

 

  

  

Feature: 
1. Height: Adjust the height 
of your lattice. 
2.Spacing: Change the 
spacing of your lattice.  
3.Angle: Increase or decrease 
the angle of your lattice by 
moving the  
slider bar.( left to decrease 
and right to increase). 
4.Preview: Preview the lattice 
on your design. You  need to 
have your design filled with 
color to be able to preview 
the lattice design. 

5. Apply: Apply your lattice to 
your design.  
Your lattice will not be create 
unless you select Apply. 

 

Exemple: 
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Draw Spiral

This function allows you to draw spiral. 

 

 

 

Procedure: 

 

 

You can enlarge the thickness of pen from Brush/Pen or 
from Color Palette. 

 

  

If you want to create this example, you 
need to apply Mirror and Duplicate 
options. Select your Spiral, then from 
Mirror transformation bar, select the 
mirror direction according to left, right 
up or down. Then 
press Duplicate and Apply, WinPCSIGN 
will automatically create a copy of your 
selection:  

Select this function from Draw menu and 
click left button mouse on the screen to 
start to draw your spiral, you can drag the 
mouse to enlarge the spiral 
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Color Scheme

This function allows you to add color to your palette from an 
image on working screen. 

Paste an image from internet, Import or scan it, then from 
the working screen click on the Color Scheme icon, 
WinPCSIGN will automatically add all the color found  
on your image to the color palette. 

 

If you want to keep the new color on the palette, click on 
the Color Palette: Set the current page to default.  

Icon:  

Personalized the tool bars.

Save the desired tool bars on the screen. 

 

 

  

  

Select the desired too bars and 
insert it where do you want. Then 
from View menu select Tool bars 
screen and press : Save my tool 
bar layout button.  
Press OK to  exit. 

You can also switch between default 
setup and yours ressing Default or  
Use my tool bar layout 

 



WinPCSIGN Pro 2014                                             New features 

12 
 

Preview and Import /Export SVG file 

Preview and Import SVG file 

This function allows you to import SVG files. Scalable Vector 
Graphics (SVG) is a family of specifications of an XML-based 
file format for describing two-dimensional vector graphics. 
SVG images can be easily edited. 

From File menu select Import SVG, WinPCSIGN will 
automatically open the SVG import option and preview 
screen. Select your SVG and click Open.  

Import PDF files

This function allows you to import PDF files. This vector 
graphics can beeasily edited. 

From File menu select Import EPS, AI PDF,  WinPCSIGN 
will automatically show the PDF import option . Select your 
PDF and click Open.   

WinPCSIGN will show you this message, we recommend to 
select OK (yes), however if the file does not open, import it 
again selecting No 
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Import AI EPS and PDF files

This function allows Encapsulated, or EPS, PostScript file. 

EPS file can contain an image or drawing. Because of the 
different ways in which EPS previews are handled, there is 
no one way to identify an EPS file. Adobe Illustrator 
Artwork (AI) Format developed by Adobe   

From File Menu. select Import and choose EPS, AI, 
PDF option. The from Import screen select the desired Ai, 
EPS, PDF File. 

The software will show you a message: 

 

Press Vector to continue. WinPCSIGN will open your drawing 
ready to send to the cutter. 

If WinPCSIGN show you a message PDF, we recommend to 
select OK, however if the file does not open, import it again 
and select No  

If you want to cut your drawing by color, Ungrouped it 
selecting the node: then from color Palette apply the 
desired color to each line (P) using right mouse click.  If you 
press Bitmap WinPCSIGN will open the in image 
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Easy selection of WYSIWYG function

if you find in your drawing not welding lines, cross line, not 
independent path, Intersection zone, double path etc  This 
function allows you to prepare your drawing before to send 
it to the cutter. 

From clipart Toolbars select WYSIWYG function, 

 

Then from Cutting preparation screen select the desired 
quality : 

 

Note: Depending the computer force that you have, select 
the High quality.  
 
Examples:   
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Unicode function
 

This function allows you copy and paste Chinese, 
Russian, etc characters or symbols from Word, Excel, 
Internet etc to WinPCSIGN keeping the same property. 
Then edit them and send to the cutter. 

Copy from your software the desired text, then go to 
WinPCSIGN and Paste your characters or symbols to the 
Working Screen: 

 

You can continue to edit and send to the cutter. 
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Arabic Fonts

Auto Vectorization mode for Arabic Fonts.  
 
This function allows you copy and paste Arabic characters 
and text. 
 
Copy your arabic text from Word, Web etc and past it to 
WinPCSIGN to the Text Editor screen. (Pres Crtl + T to 
open the editor) Then select Arial from Font menu 
and Press OK   

 

Press OK to convert and send the Arabic text to workings 
screen: 
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Once the text is on working screen, you can continue to 
edit. Then send it to the cutter: 
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Piercing, Embroidery, Scissor and lattice tools
 

 
 
To open the this function 
select Pouncing Scissor 
from Tools menu  

 

 

 

 

 

 

 

 

  

The piercing tool is made to 
make small hole into your 
material, simply select the 
spacing you want to have 
between each hole and 
press applyThis 
transformation tool is 
perfect for embroidery in 
thick material like foam.This 
tool require the FunTime 
piercing blade.  

 

Example: 
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Hole path distribution

The Embroidery tool is perfect to make circle hole into paper 
material, simply select the spacing you want to have 
between each circle and the radius of each circle and press 
the apply button.This transformation tool is perfect for 
embroidery or special transparence effects. This tool doesn't 
require any special blade: 
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Scissors tool
 

 

 
 
 

 

The scissors tool is made 
to transform any shapes 
and apply a decorative 
scissors effects on it.This 
tool is really easy to use : 
simply select the scissors 
of your choice and the it's 
size. Click apply and see 
the result! 
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Fit Objects to path

 

 
 

 

 

 

 

 

 

 

 

 

 
For the follow examples I choose the option: Top, Center and 
Space 0.25 

  

  

You can also select: 
 
Position: Your selection will start from:  Top Bottom Left Right. 
Inside Your selection will be inside of your path.  
ABC Your selection will be mirror and inside of your path. 
Center Your selection will be take by the center . 
NON Rotation Your selection will not rotate on the path. 
Spacing Enter the space value between each copy. 

 

This option allows you to 
distribute 
your design or image  
along to the select 
paths. 
You can also use this 
function to fit 
rhinestone to path 
Select your design and 
the shape where  you 
want copy it.  
Attention your design 
has to be in front of the 
object  to be used as a 
guide Choose Fit object 
to Path  
from Shape menu, 
WinPCSIGN  will open 
object to path screen. 
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Write vertical automatically
 

Shortcut:   

This option allow you to write or change a text orientation 
to Vertical or Horizontal on one click 
 
Write your text, then from Write Text bar, click on 
the icon ab vertical. WinPCSIGN will 
automatically set your text vertically. To  cancel this option 

click on the icon AB ( horizontal) 
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Color Palette 
 

Shortcut :   
Pen Size and Style from Color palette selection:  
    

  

 You can change the thickness and the Style of the pen 
directly from Color palette  

 
Select your design, then from color palette move the scroll 
bar or enter the desired thickness value.  
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Welding Plus
 

 
This functions allows you to weld 2 element and subtract 
the filled part: 

  

Select your drawing. From Tools menu, select 
Welding,  and click on Welding plus. WinPCSIGN 
will automatically weld your selection. 
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Free hand tool
 

This function allows you to draw anything you want. 
This tool works great with graphic tablet like 
Wacom tablet. 

Select Free Hand icon from right tool bars: 

 
Then select the pencil, your line size and the color that you 
want and start to draw your shape on screen. 

 

If you want to create a hole into a black zone, simply use 
the white color. It's really all about logic. The black shape 
you see is what is going to be cut. 

You can use the eraser tool to erase a line you've created. 
Take some times to test the eraser tool, it doesn't work the 
same way the pencil 
does. Press the OK 
button and you are 
ready to go: 

 

 

 

The result depends on your 
calligraphy: 
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Default font

 

This function allows you to save the selected font like 
default. Anytime that you open the software and write a 
text, WinPCSIGN will use your default font. 

Select  icon, then from Font menu, select your desired 
font and press Default button: 
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Overcut

 

The software allows you to extend the cut over a closed 
path. It will continue cutting the object along a specified 
distance. This ensures that the object is cut out completely. 

Select this function from Options in Cutting Control Panel. 
(Cut Project) Then enter the desire value and click OK 

 

Default value 0 (Zero) 
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Watermark
 

A watermark is a recognizable image or pattern that 
appears as various shades of lightness/darkness when 
viewed by transmitted light (or when viewed by reflected 
light, atop a dark background), caused by thickness or 
density variations in the image 

Select your image then from File menu select Export , then 
chose JPG, BMP, PNG etc. From Bitmap properties, 
select Watermark Setup, write your desired text and 
color. Apply the desired % transparency using the slide bar, 
and press Ok and export it.    
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Rhinestone Feature:shape an image 

General 
 
WinPCSIGN Pro allows you to create Rhinestones stencils 
converting any shape to circles. To open Rhinestones 
screen, select stone icon from zoom bar. 
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Procedure:  

  

 

Stone touched detection 

This function allows you to show the stones (circle) are 
touching each other in your template. 

Procedure: 

Select Stone touch function from Rhinestones screen. The 
software will automatic zoom the touched stones on the 
template, so you can now separate it: 
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Stone touch suite: 

 
 
If you click stone touch button again WinPCSIGN will 
continue to check in your template. 

If you do not like your stones templates press   icon, 
and start over 
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Rhinestone Color Selection 

This function allows to select in your rhinestone template 
the stone (circles) by the same color. 

Procedure: 

Click on your template the color of the stone that you want 
to select, then press the Brush Color button. WinPCSIGN 
will automatically select all the stones that are of the same 
color. You can now move your selection and do whatever  
you want: change the size, the color, delete etc. You can 
also grouped by selecting the icon:  

 

Hint:  
If you want to change the size of your selected 
rhinestones, just double click on a new SS size 
selection screen.      
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You can also select Erase Original button. This function will 
delete the outlines of your design. If the Detect 
corner function is checked, WinPCSIGN will decide a better 
gap between the stones. 

If you do not like your stones templates press   icon, 
and start over 

If you want enlarge your template, keeping same SS. 
Select No resize box. 

 

Rhinestone Size selection 

This function allows to select in your rhinestone template 
the stone (circles) by same size even are not the same 
colors. 

Procedure: 

Click on your template the size of the stone that you want 
to select , then  
press the Size button. WinPCSIGN will automatically select 
all the stones that are of the same  
size.  You can now move your selection and do whatever 
you want: change the size, the color, delete etc.  You can 
also grouped by selecting the icon:  
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Hint: If you want to change the size of your selected 
rhinestones, just double 
click on a new SS size selection screen    

You can also select Erase Original button. This function will 
delete the outlines of your design. 
If the Detect corner function is checked, WinPCSIGN will 
decide a better gap between the stones. If you want enlarge 
your template, keeping same SS. Select No resize function. 

If you do not like your stones templates press   icon, 
and start over 
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Rhinestone color + Size selection 

This function allows to select in your rhinestone template 
the stone  by same size and color 

Procedure: 

Click on your template the size or the color of the stone 
that you want to select , then press the Color + 
Size button. WinPCSIGN will automatically select all the 
stone that are of same size an color  You can now move 
your selection and do whatever you want: change the size, 
the color, delete etc. 

 

You can also select Erase Original button. This function will 
delete the outlines of your design. 
If the Detect corner function is checked, WinPCSIGN will 
decide a better gap between the stones. 
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If you do not like your stones templates press   icon, 
and start over 

Hint: If you want to change the size of your selected 
rhinestones, just double 
click on a new SS size selection screen   

If you want enlarge your template, keeping same SS. 
Select No resize box. 

Stone dropping 

This Function allows you to drop a Rhinestone in your 
document. 

Procedure:   

    

 

 

Click Spacebar to release this function. 

 

Select the SS stone then click on the hand icon 
and click where you want drop rhinestone: 
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Center rhinestone line 

Center line is a type of Vectorization for images or text. This 
option allows you create a center line of the stone along of 
the shape or text. This function works with text and 
images filled (Brush) 
 
Procedure to create Center line: 

Click on your template, then select the desired SS size and 
the spacing between each stone. You can also select Erase 
Originalbutton. This function will delete the center line of 
your design. Select Center line and press Apply. 
WinPCSIGN will automatically apply the stones to your 

design, review it, If you do not like it, press  cancel icon 
and start over. You can also move your selection and do 
whatever you want: change the size, the color, delete etc. 

 

If the Detect corner function is checked, WinPCSIGN will 
decide a better gap between the stones. 
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Fit rhinestone following a shape 

This function allows you to fit the rhinestone following a 
shape or text using different SS stone size. 

Procedure: 

Select your design, them from rhinestone screen choose 
the Set SS function, select the desired stone size  
that you want, the Spacing and press OK.  Then 
click Apply button and WinPCSIGN will utomatically fit the  
stones in your selection. For a better view, we recommend 
to convert your logo in black color from Color palette (B) 
(P) 

 

You can use the arrow selection function and move the 
stones and do whatever you want: change the size, the 
color, delete etc. 

Attention: The thickness of your design cannot be 
wider than 60SS  (0.563 in)   
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You can also select Erase Original button. This function will 
delete the outlines of your design. If the Detect 
corner function is checked, WinPCSIGN will decide a better 
gap between the stones. 

If you do not like your stones templates press   icon, 
and start over 

  

Fill Rhinestone Island full or partial  

This function allows to Full fill stone to your rhinestone 
template or apply a partial fill 

Procedure Full Island: 

Click on your template, then select the desired SS size and 
the spacing between each stone. 
You can also select Erase Original button. This function will 
delete the outlines of your design. 
If the Detect corner function is checked, WinPCSIGN will 
decide a better gap between the stones. 
 
Select Full and press Apply. WinPCSIGN will automatically 
apply the stones to your design, review it,  if you do not like  
 

it, press  cancel icon, and start over: 
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Procedure Partial: 

Click on your template, then select the desired SS size and 
the spacing between each stone. 
You can also select Erase Original button. This function will 
delete the outlines of your design. 
 
If the Detect corner function is checked, WinPCSIGN will 
decide a better gap between the stones.   
 
Select Partial  and number of depth then press Apply. 
WinPCSIGN will automatically apply the stones to your 
design. 
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Review it and if you do not like it, press  cancel icon 
and start over 

 New rhinestone Texture 

This function show all the stone library and allows you select 
the stone. After you have created your template you can 
apply stones to simulate the final result. 
 
Procedure: 

Select your template and double click on the desired stone. 
WinPCSIGN will automatically apply the color stone to your 
template; 
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You can also drag with the mouse rhinestones to your 
image or select the new function stone dropping 
 
Hint: If you want to change the size of your 
selected rhinestones, just double click on a new SS size 
selection screen.  

 If you do not like your stones templates press  icon, 
and start over 
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Erase Original 

If this function is checked WinPCSIGN will delete the 
outlines of your design. If you unchecked, WinPCSIGN will 
keep the original lines: 

 
 

 

Attention: This function is checked by default. 

Detect corner 

 
If the Detect corner function is checked, WinPCSIGN 
will decide a better gap between the stones 
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Attention: This function is checked by default.  

Rhinestone Preview color screen 

This function allows you to change the color of screen. For a 
better preview of your rhinestone templates, we 
recommend to select black background 

Procedure: 

From Rhinestones screen , select the desired color 
from Preview  WinPCSIGN will automatically 
change the color of screen.  If you want to change the color 
again, just click to another color: 
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Lasso selection 

This function allow you select objects from your 
design using the Bezier tool 

Choose Lasso from Rhinestone Screen:  
 
With help of the bezier, draw around the stones, objects or 
design that you want to capture. The selected item will be 
appear with little white squares,  then press one  
of arrow  Up, Down, Left, or Right from your keyboard 
and move them to another position  or press delete key. 
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If you do not like your stones templates press   icon, 
and start over 

  

 

Rhinestone SS Stone info 

Select Info tab from Rhinestone screen. WinPCSIGN will 
show this Drawing Data screen. You can also set the 
information about: Cost, Profit, Stone quantity SS Size, 
Price, Total. 
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Procedure: 

Select Info from Rhinestone screen, then double click on 
one of the price and enter the cost. Then 
select Calculator to open Rhinestone calculator screen. 
Enter the the desired value and press Ok to get your cost 
and profit 
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Rhinestone Bitmap converter 

This function converts an image to rhinestones templates. 

Procedure: 

 

WinPCSIGN will automatically create a copy of your image 
converts in rhinestone templates:    

Copy and paste an image 
to WinPCSIGN, then select 
the image an 
open Rhinestones  
transformation screen. 
Select the desired 
stone SS size and the 
stone Spacing and  
click Apply button. 
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You can delete the undesired stone or add new one 

 

Warning: The final rhinestone templates can contain 
thousands of stone.  

If you want enlarge your template, keeping same SS. 
Select No resize box. 

  

You can also convert the 
tone Circles to Squares or Star
s. Open Circle bar and click the 
desired function: 
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Stone Grid Fill 

Fill up your selection using different kind of 
fill: Standard, Horizontal and Vertical shifting 

Procedure: 

Select your design, then from rhinestone screen select the 
SS size and the Spacing between finally select the 
desired Fill  from Grid Fill function and press Apply button 
  

 

Review it, and if you do not like , press  cancel icon, 
and start over 
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Change to circle 

This option allow you to convert objects on the screen to 
perfect circle. 

Procedure: 
 
Select your design , then press the button Change to 
circle  

  

WinPCSIGN will automatically change all the selected 
elements to perfect circles trying to keep the size of each  
object.  
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Example: 

 

If you select  , and WinPCSIGN does not find 
circle on your design, it show the follow screen message: 

 

Click Yes, if you want convert the objects to rhinestones 
circle 
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Distribute space between object 

This function allows you insert an spacing between object or 
rhinestone. 

Select this function from Justification Bar, then select the 
desired object and press on the icon: Horizontal or Vertical 
arrow, depending of your selection. 

Enter the desired value and press OK 

 

Rhinestone Text 
 
Open the Create fonts bar from Toolbars, View menu. 
or select it from Text menu 

In order to create rhinestone text, you need to select one of 

the single-line font 

Rhinestone & Engraving font from  Font menu,  
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enter the Height, then press OK 

 

 

 

Write your desired text, then from Rhinestones creen  

select the SS, Spacing and Outline: 

 

You can also create your own single lines fonts. Read Center 

line function and also Create Fonts 
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Rhinestone fonts creation 

This function allows you to create your own Rhinestone 
Fonts 

Procedure: 

From Rhinestone screen select Font tab, then click Find 
(1), to open Font menu. 
Select the desired font style that you want to use to create 
your rhinestone font, 
between Cutting or TrueType . You can also select from 
your Font collection DVD  
pressing Catalogue or Search. 
 
Enter your font name in New Font Name (2), Enter 
the Font Height (3), then enter 
the  Spacing and Stone size (4),  
Note * : You need to enter the stone size 
in mm or inches    
 
Press Set New (5), to start to create your rhinestones 
font: 
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Finally you can select your final rhinestone font 
from Font menu  Cutting. 

You can also select Make All Letter function, the software 
will automatically create your font. if you want review your 
font, select make Revision of the original , then press 
Replace to save tour reviewed letter, then continue to 
check. 

You can also select this function to add a different option to 
your fonts. 

The First letter will be create 
is A.  
Before to pass to the second 
letter we  recommend to 
check the spacing between 
each  
circles. You can move, 
duplicate, delete etc. Then 
press Replace (6) to 
continue creating  
your alphabet.   
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Procedure 
After selecting the style, spacing and stone SS size, click on 
the desire function and press Set New(5) if you like, you 
can continue to create your font    

 

  

Rhinestone Spray 

This function allows create rhinestone shape or fill your 
templates with the desired 
rhinestone stone: 

Procedure 
Select the desired SS stone size and the Spacing, then click 

on Spray Icon   
Press left button down and move the mouse to spray on the 
desired direction. 
You can fill an object, create a shape or even write a word 
using this tool. See example: 
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If you want change the jet or spray size, 
select Spray /Freehand Spray.  
This screen offer you many option to change and/or select 
different kind of spray: 

 

Freehand Spray: This 
option allows you to 
change the size spray  
Use selected stones 
size:  If you select this 
option , you need to 
click Set SS to select 
your stone  size. The 
function will spray using 
your stone selection  
 
Spray on selected 
path: If you click this 
option, the software will 
spray your selected 
path. If you want to 
reduce or enlarge the 
jet, select Spray 
size bar 
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Select your SS and the desired density, select your object 
on the screen and click Spray icon 

 
If you dont like, click red X to cancel and start over. 

Use selected stone size:  If you select this option , you 
need to click Set SS to select your stone  size. The function 
will spray using your stone selection  
 
Spray Density: This option allows you to spray more or 
less rhinestone.  
  

 Select path Inside/Outside 

This option allows you cut your template using a path. 

Procedure: 

Create your template, draw your desired shape then 
 depending that you want 
click Inside or Outside. Select and drag the result: 



WinPCSIGN Pro 2014                                             New features 

60 
 

 

If you do not like your stones templates press   icon, 
and start over 
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Rhinestone composer 

This function allows you preset your own rhinestone pattern 

 

Finally you can select your preset patterns from Rhinestone 
Screen: 

 

Read also Use Pattern 

 

 

Procedure: 
 
Select Creation from 
Rhinestone screen. Then 
select the desired stone 
SS (1) size  and 
press Add (2). Continue 
to select your stone and 
see your 
composition (3) 
If you like it, just 
press Save4  or the 
click Erase icon to 
delete:     
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 Rhinestone Edition 

This function allows you to edit your rhinestone patterns. 
This screen offer many tool to correct, delete, add and 
distribute the stone. You can convert  
objects to Circles and Circles to Star, Square etc. 

 Resize stone size. this function allows you to resize the 
stone of your text  
or patterns. Select your job then from Stone SS screen 
choose the new ss value 
and pres Resize button: 

 
  

Fill between two stone, this function allows you to add 
stone to your path. 
Select minimum 2 the stone. WinPCSIGN will automatically 
add the missing 
stone keeping same space: 
 

 

Distribute spacing between stones, this function allows 
you distribute the 
spacing between two stone in a selected rhinestone path: 

 

Copy Selected, this function allows you to copy a selected 
group or line the rhinestone. 
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Select the rhinestone that you want to copy, and then press 
the arrow in the direction that you want get the copies. 

Fix intersection, this function allows you to delete in a 
rhinestone group or line,the stones that does not have the 
same space between ,taking the Distance for 
intersection value entered by you. (we recommend to 
measure the space between the stone before to apply  
this function. Tool/measure)  

 

Procedure Custom: 

Select the design that you want use like pattern, then 
press Make pattern with selection (1)button. Select your 
original rhinestone patterns and press Convert selected 
new pattern (2) button. WinPCSIGN Will automatically 
convert your template with your own pattern.    

Procedure Convert to: 
Select your design , then press Converter from Rhinestone 
screen. WinPCSIGN will automatically change all the 
selected elements to perfect circles trying to keep the size 
of each object. You can also converted circles to star and 
start to square   
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T-Shirt , profit etc. 

Procedure: 

 Click this icon to open T-Shirt screen. 

 

Then select Front or Back side (1) of a blank  
T-shirt and color. Then select the heat transfer 
material (2) and size (3). Draw your design or 
write your text directly on T-shirt. Then select the desired 
option like Distortion or Arc text (4) 

If you want to create more than one T-shirt,  Enter T-shirt 
cost (Garment 5)   
and the quantity of shirt that you want to create (6) and 
select Calculator (7) enter the Height Length 
and Price of your material (8) or select it from your old job 
list (9). Click OK (10) to return to T-shirt screen.  
 
Finally verify all the information that you entered and if you 
like press Make It (11) Make it button will place all your 
design on the screen ready to send to the cutter. 
or start over. 

If you like, you can save in PIC files. Press the icon 
 (12) WinPCSIGN will automatically create a group 
named TShirt in Local Clipart 
 
If you want to show your creation to your customer, you 
can export it in JPG file.(13)  Click 

on the icon  to export your design. 
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Monument 

Double Ogee 

This tool was developed to create cemetery Headstones. 
 
This term is used for a molding with an ogee-shaped 
profile, consisting (going from low to high) 

Procedure: 
Select Ogee function from Draw menu. WinPCSIGN will 
open this screen: 

 

Enter the Width and Height value, then enter the 
desired H2 molding and Taper value. Press ADD . 

Example: 

 

You can also select Texture from Color Palette and apply  
to your stone. 

http://signmax.us/videos/CreateOgeed_demo/Create%20Ogee_demo.htm
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Select also Monument Font: 
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Distortion

Use this function allows you to convert your text to different  
shape . 

Procedure: 

Select your text, then from Tools menu select Distortion 
function. Choose the desired shape and click Apply. 
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